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About Harmony Advanced Reporting 
 
Harmony Advanced Reporting (Advanced Reporting) is the custom reports module for 

the Harmony for Aging (HfA) product line. Built upon Microsoft 2010 technology, 

Advanced Reporting is a web-based, self-service reports environment that enables 

authorized users to access the organization’s Harmony-hosted data warehouse (DWH).  

The solution runs on Microsoft technologies: 

• SQL Server 2008R2 – database for the solution. 

• Report Builder 3.0 – development studio for dataset/report design and creation. 

• SharePoint 2010 – storage for created reports, datasets, and report schedules. 

 

Workbook Introduction 
 
This workbook is the second training manual in the Advanced Reporting educational 

series.  Those who have not used similar products previously are advised to obtain and 
review  a copy of Harmony Advanced Reporting - Getting Started Guide for Report 

Writers.  This first manual in the series provides essential training on: 

• Interfaces and navigation in the system 

• Recommended processes for developing reporting objects 

• Creating data sets, reports, and schedules 

• Working with the SharePoint portal component 

This manual, Harmony Advanced Reporting - Training Workbook for Report 

Writers, is provided to give you the opportunity for additional practice beyond the 

“Getting Started” training you may have recently received. The workbook will assist you 

in applying the features and functionality of the module. As you complete the exercises, 

you will develop proficiency and gain confidence in working with the reporting solution.  

We assume that you have met the prerequisite for basic knowledge of SQL, that you 

have completed the “Getting Started” training, that you already have access to an 

Advanced Reporting instance, and that you can log in and do basic navigation without 

help beyond your reference materials, if needed.  It may be helpful for you to keep the 

Getting Started Guide handy as you go through the practice exercises.  

Users of the Training Workbook complete the exercises working in their organization’s 

configured module rather than in a dedicated training environment.  Working in the 

“native” location enhances familiarity with  the organization’s data, which is an important 

success factor in getting the most from the system.  
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Naming Conventions 

• You will be working on these exercises within the live solution established for your 

organization. You’ll need to use a distinct naming convention so as to differentiate 

between “real” work and work you’ll produce for your skills training.  

• For names of all the objects and reports created during training, we recommend you 

preface the name with an X. This will make your training objects easier to group and 

identify.  If there are multiple developers in your solution, you may need to use X plus 

your two initials as a prefix.  

• Eventually you will want to keep your training items from mixing with your production 

work. You can store your training work in a separate folder, or you will can delete 

your training items from the system. Either way, having all of your training work start 

with “X” will make it easier to identify and locate the non-production files.  

• Your organization is responsible for setting a naming convention for the files created 

in the solution. We recommend that all objects have subject-creator-date-time 

identifiers to aid in version control, and that report definition names have a 

mechanism to reference the associated shared dataset.  

 

Learning Tips 

• Much of the learning for this solution has to come from your own willingness to invest 

time and energy in developing your skills as a reports developer. We recommend 

spending a little hands-on time every day while trying to grow your proficiency.  

• Bear in mind that if you only work with your own training objects, you cannot “hurt” 

anything that’s “live” in your setup.  So don’t be afraid of making mistakes, because 

that’s often the best was to learn how to do something properly.  Simply restrict your 

mistakes to those objects that are not essential to your production users.  

• It can be be helpful to play with a copy of a working report (name it with your training 

prefix) to understand how the report works and how the parts were created.  When 

you need to make “real” changes to a working report that’s in use, it’s safer  to work 

in a copy of the report until you are happy with your changes, and then replace the 

existing report with the newer version after you’ve tested it and verified its suitability.   

• Have fun! Your learning will be more enjoyable if you can embrace that there will be 

challenges and take an attitude of patience and determination rather than frustration.   

• Look for and sign up for developer forums where you can obtain tips and tricks from 

other developers.   

• Spend time talking to other report writers, and make time to share your own insights. 

Others will find new ways to apply what you share, and you’ll both learn something 

as you exchange information. 
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Resources 

• Microsoft has a wonderful library of resources to assist you in learning more about 

the components: 

o http://technet.microsoft.com/en-us/library/dd239338.aspx 

This site has tutorials to help you build skills in Report Builder. 

o http://technet.microsoft.com/en-us/library/ee706623.aspx  

This site has detailed technical information about Report Builder features.  

 

• The Internet is loaded with resources for training and quick reference: 

o http://www.sqlcourse.com/ - a FREE, self-paced basic to intermediate 

SQL course. Great for those just getting started, or can be a good refresher 

for those with basic skills.  

o http://weblogs.sqlteam.com/jeffs/archive/2007/03/30/Quick-Access-JET-

SQL-to-T-SQL-Cheatsheet.aspx - This site has a cross-reference that can 

help you revise MS Access (JET_SQL) queries to SQL SERVER (T-SQL) syntax. 

o http://www.databasejournal.com/features/msaccess/article.php/3865076

/T-SQL-Equivalents-for-Microsoft-Access-VBA-Functions.htm  - This site 

has a similar cross-reference to help you convert MS Access VBA functions 

to SQL Server T-SQL syntax.   

o http://www.devguru.com/technologies/t-sql/home.asp - This site has a 

quick reference of T-SQL functions including query operations, stored 

procedures, triggers, and views.  

o http://blog.axiomdynamics.com/2010/01/quick-reference-for-t-sql.html - 

This site has a downloadable, three-page reference containing definitions for 

inner and outer (left and right) joins, as well as a concise illustration of the 

difference between a query and a stored procedure.  

• Other resources you might not have considered: 

o YouTube – Developers and Trainers often post clips showing setups, 

methods, techniques, or features. You can even see a series of business 

intelligence clips.  If your organization prohibits viewing YouTube in the 

workplace, you can explore at home.  

o Wikipedia – includes definitions and explanations for many glossary terms 

and SQL concepts such as joins. 

o Experts-Exchange – For a low monthly fee, you can access a forum that 

provides expert responses to your questions. If you solve just one tricky 

problem a month with this service, you’ll save enough time to make it worth 

the subscription.   http://www.experts-exchange.com.  
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Workbook Structure 

 
We recommend you perform all of the exercises, and in the order of presentation. While you 

can go back and repeat exercises (or better yet, create your own from the ones provided) 

it’s better for developing your initial skills if you work the items in order.  

 
� Preparation: Create SharePoint folder for storing your work.  

� Section I helps you develop skills in using Report Builder to create datasets:  

o Exercise 1:  Create a Consumers Dataset 

o Exercise 2:  Join Two Tables 

o Exercise 3:  Add a Filter and Parameter 

o Exercise 4:  Edit as Text - Use an “OR” Clause 

o Exercise 5:  Advanced Dataset with Multiple Joins 

� In Section II, you will build report definitions: 

o Exercise 6:  Build Table Report 

o Exercise 7:  Build Chart Report  

� In Section III, you will work with an embedded dataset report: 

o Exercise 8a:  Create Report with Embedded Dataset 

o Exercise 8b:  Insert Column and Concatenated Field 

� In Section IV, you will work with advanced expressions: 

o Exercise 9a:  Create Unduplicated Clients Report 

o Exercise 9b:  Create Expression for “Age-Range” 

o Exercise 9c:  Create Parameter Filter by Drop Down 

� In Section V, you will practice with SharePoint components: 

o Exercise 10: Rename Folder  

o Exercise 11: Add Document/Move Files to Folder 

o Exercise 12: Change Report Object Name 

o Exercise 13: Establish Report Subscription 

o Exercise 14: Delete File 

o Exercise 15: Restore File 
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Preparation: Create New Folder 
In this exercise, you will create a new folder in your SharePoint site’s Reports Library.  
 
Follow the steps below to add a new folder. 
 

 
 
First, log in to your organization’s SharePoint site. 
 
Step 1:  Locate the links in the Quick Launch area on the left of the page. 

 Go to the Reports Library. 

 
Step 2:  On the Library Tools tab, click Documents. 
 
Step 3.  Click the New Folder button. 
 
The system will return the New Folder Window. 
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Step 4:  Name the folder.  (Folder Name is a required field).  
 

Think about what to call this folder to make it distinctly “yours”, especially if there are 

multiple users in your organization.  Your training work should probably be labeled as 

a training folder with your name. 

 

Step 5:  Click Save.  
 
The system will place the new folder into the Reports Library, ordered by folder name. 
 

 
 
Now you have a place to store your training work. You’ll want to save all of your objects 
to this location as you complete the exercises in this work book.  
 
Your completed exercises can serve as reference items later, because the scenarios are 
designed with consideration for frequently-used features and settings. 
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Section I – Shared Datasets 

Exercise 1:  Create a Consumers Dataset 

In this exercise, you will develop a Consumer dataset (.rsd file) that can serve as a shared 
dataset for other reports you will build in later exercises.   
 
A dataset using only the CONSUMERS table can be useful when you need to count 
attributes in your consumer base, such as reporting on the number of people in certain age 
or income groups, or a count of those meeting other demographic criteria.  
 

• To create the dataset, select only one table, CONSUMERS.   

• From this table, select the following fields: 

� CONSUMER_AGENCY_DES 

� RES_COUNTY 

� AGE 

� PRIMARY_ETHNIC_GROUP 

� GENDER 

� IS_VETERAN 

� NUM_ADLS 

� NUM_IADLS 

� CONSUMER_UUID 

� Optional: You may select additional fields from the CONSUMERS table. 

 

• Save As and name the dataset Exercise 1.rds. 

• Save your work  to your SharePoint folder. 

• After you save the work, run the query (click the Run query button at the top of the 

page) to check the results.  

 

Give it a try – use the hints below as needed, then check your results against the debrief on 

the next page.  

 

 

Hints: 

 

• Connect to Report Builder via AgingNetwork.com. 

• Follow the steps in the Getting Started Guide/Create New Dataset. 

• Include your initials in the dataset file’s name. 

• Your folder should exist in the Reports Library. 
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Exercise 1 – Debrief 
 

1. Your Report Builder screen should look like the following: 

 

 
 

2.  Did you notice?  Report Builder will add your fields to the Field pane in the same order 

as you select them from the database view pane.  If you are selecting an entire table, the 

fields will come over in the same order as they appear in the database view.  In the 

Selected fields pane, you can move the fields up or down in the list by using the blue 

arrows to the right of the red X.  To remove fields from the selection, unclick the box in 

the Database view column or highlight the field in the Selected fields pane and click the 

red X.   Notice that with either approach to deletion, the “undo” button doesn’t work. (So 

delete with care).  

 

3.  There are no relationships to be defined, because you are pulling fields from only one 

table. When you select fields from two or more tables, you must establish the 

relationships between the tables being used, setting the correct number of joins. When 

you join five tables, you need four joins. When you join three tables, you need two joins. 

With one table, no joins are needed.  

 

4.  You should have done a “Save As” in Report Builder to enable the File > Save.  
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Exercise 1 – Debrief (continued) 

 

5.  Hopefully you named your file something like gb Exercise1 mmddyy.rds. 

 

6.  Note that datasets are saved as .rds files.   

 

7.  The correct place to save the file is in your folder within the Reports Library.  

 

8.  Move the CONSUMER_UUID to the top of the Selected Fields list.   

• Run the query again.  

• Your results should now show the CONSUMER_UUID column at the far left. 

 

9.  Notice that when you run a dataset, the query just returns the data. There are no totals or 

counts to confirm the number of records returned. You will need to use the query in a 

report definition to see totals and counts.  

 

 

Notes: 
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Exercise 2:  Join Two Tables 

In this exercise, you will develop an expanded Consumer dataset (.rsd file) that includes 

fields from two tables.  When there are multiple tables in your dataset, you must also define 

at least one relationship to “join” each of the tables involved.  

 

• Select the CONSUMERS table and bring over the following fields: 

� CONSUMER_AGENCY_DES 

� RES_COUNTY 

� AGE 

� PRIMARY_ETHNIC_GROUP 

� GENDER 

� IS_VETERAN 

� NUM_ADLS 

� NUM_IADLS 

� CONSUMER_UUID 

� Optional: You may select additional fields from the CONSUMERS table. 

 

• Select the SERVICE_DELIVERIES table and bring over the following fields: 

� Bring over all fields in this table. 

 

• Establish the correct relationship between the two tables. 

• Save your work.  

• Run the query.   

 

Give it a try – use the hints below as needed, then check your results against the debrief.  

 
Hints: 

 

• To complete the Join, you will need to find a field that the tables have in common. 

• To add a relationship (the join), you will need to first turn off the Auto-Detect setting. 

• You will need to define the join as inner or outer, left or right – most likely,  

o Your join will return all of the records from the CONSUMERS table along with 

any matching records identified in the SERVICE_DELIVERIES table. OR 

o Your join will return all of the records from the SERVICE_DELIVERIES table 

along with any matching records identified in the CONSUMERS table. OR 

o Your join will return only the records having data in both tables.  

• At least one link in the reference list carries a nice explanation of “Join”. 

• You could start with your previous query, and edit that to bring in the new table. 
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Exercise 2 – Debrief 
 

1.  Your Report Builder screen should look like the following: 

 

 
 
Numbered areas on the screen above are explained in more detail below: 
 
#1 – Unless you selected the entire table, the Database view pane will show the 

CONSUMERS table as marked with a gray checked box to reflect a partial selection.  

#2 – If you correctly selected the entire SERVICE_DELIVERY table, the Database view will 

show the table as a white box with a check mark.  

#3 – One use of these two tables is to see which Consumers do NOT have Service 

Deliveries.  Therefore, we’ve chosen CONSUMERS as the left table – we want to bring in 

ALL CONSUMERS and check for a match in SERVICE DELIVERIES.  This results in the 

need for a LEFT OUTER Join.  The join is contextual; that is, if we’d reversed the two tables, 

we could have done a RIGHT OUTER Join to get the same results.  

#4 – The Auto-Detect button takes a little getting used to.  You have to click the Auto-Detect 

button to turn it off, and then you have to click the tables button to add a relationship. To edit 

the fields that are joined, highlight the Join Fields value and click Edit Fields.  

#5 – As with most datasets, the most valuable field is the CONSUMER_UUID.  The 

CONSUMER_UUID field appears in most of the available tables and is always a good 

starting point to define a join between two tables.  
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Exercise 3:  Add a Filter and Parameter 

Filters and Parameters are useful when you need to limit the records to return only those 
meeting a certain criteria.  In query syntax, these conditions are added as clauses that read 
like so:  “WHERE <field name> IS / IS NOT / LIKE / NOT LIKE / GREATER THAN / “ etc.  
 
 Filters will apply the condition to the query.  
 
A Parameter is a mechanism that lets you prompt the user at run time to define a specific 
value for a filter.  
 

• For this exercise, pull up and edit (open) the dataset you created in Exercise 2.  

• Add a filter to return only those records with services delivered in or after 2005. 

• Make the filter a Parameter. 

• Save your work with a new file name. 

 

 

Give it a try – use the hints below as needed, then check your results against the debrief on 

the next page.  

 

 

Hints: 

 

• To add a filter to your query, click on the icon that looks like a funnel. 

• To define the filter, you will need to identify the Field Name, Operator, and Value. 

• Use the field SERVICE_YEAR in your filter.  

• You won’t be able to see the Parameter in action until run time.  

• We’ll build on this file in the next exercise, so be sure to save your work.  
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Exercise 3 – Debrief 
 

1.  Your Report Builder screen should look like the following: 

 

 

 

Explanation: 

• Note the Filter icon in the Applied Filters section of the Query Designer pane. This is 

the button you must click to define a filter.  

• Note that to make the Filter a Parameter, simply check the box on the right.  When 

this box is checked, the user will need to specify a value for the report at run time. In 

other words, the system will prompt the user to define the value of the filter when the 

report executes. If you do not make the Filter a parameter, this dataset will always 

return only the records where SERVICE-YEAR is more than or equal to 2005. If you 

make it a Parameter, the report will still be filtered on SERVICE_YEAR, but the 

USER will define “more than or equal to what year, if any”.  

• You won’t see the parameter in action when working with the dataset, but you can 

prove that it’s there if you click on the Edit as Text button. A parameter has an “at” 

(@) sign. This toggles the view so that you can see the syntax for the query, which 

should look like this: 

WHERE  HAR_SERVICE_DELIVERIES.SERVICE_YEAR >= @SERVICE_YEAR 
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Exercise 3 – Debrief (continued) 

• As you develop more skills with filters, be aware that you can combine them using 

AND/OR statements.  

• In the example below, the filters will return only those records  

o meeting the SERVICE_YEAR criteria (parameter) AND  

o containing a value in the MEDICAID_NO field.   

  

o The default for multiple filters is AND. However many you apply, the system 

will connect them with AND. 

o Bear in mind that you can “filter yourself right out of data.”   

Imagine if you entered two filters like so: 

• CONSUMER.AGE is less than or equal to 100 AND 

• CONSUMER.CONSUMER_GROUP_AGE is more than or equal to 

100 

• There would be very few records that meet both conditions. 
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Exercise 4:  Edit as Text – Use an “OR” Clause 

Thus far, we’ve built our queries using the visual design section of the tool. Report Builder 
also has a powerful Text Editor that can be used to directly modify the syntax of the query 
you’re designing.  As you develop your SQL skills, you will find the Text Editor to be more 
and more useful.  
 
Another important use for the query editor is that you can copy and paste queries from 
elsewhere into the query designer and then adapt the query for use in Advanced Reporting.  
This enables you to recreate reports you may have built in MS Access or a prior version of 
Advanced Reporting.  
 

• For this exercise, pull up and edit the dataset you created in Exercise 3.  

• Click the Edit as Text button. 

• Modify the query so it will return rows meeting the following criteria: 

o WHERE SERVICE_YEAR is more than or equal to (parameter value) 

o OR 

o WHERE record has no MEDICAID_NO. 

• Save your work with a new file name. 

 

Give it a try – use the hints below as needed, then check your results against the debrief on 

the next page.  

 

Hints: 

 

• To add a second filter to your query, click on the icon that looks like a funnel and 

include MEDICAID_NO is (null).   

 

 
 

• You won’t be able to use this filter as it exists after you add it to the query – you’ll 

need to modify the “AND” to “OR”.   
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Exercise 4 - Debrief 
 

1.  The Edit as Text button is located at the top of the Query Designer page: 

 

2.  Once you click Edit as Text, the system will present the SQL, which can be modified by 

directly typing into the editor.  Change the “AND” in red below to “OR”.  

 

 

 
NOTE:   

ONCE YOU  MODIFY A QUERY IN THE TEXT EDITOR, YOU CANNOT GO BACK TO 

THE GRAPHICAL INTERFACE TO MAKE ADDITIONAL CHANGES.  

 

If you click the Edit as Text button again, all modifications in the text editor will be lost.  

 

Additional Considerations: 

  
a.  Why can’t you leave the filter as “AND” instead of “OR” ? How do the query results 

differ when you use “AND” instead of “OR”? (Think about it in terms of people in your 

classroom…the difference between GENDER = Male AND HAIR = Brown vs. 

GENDER = Male OR HAIR is Brown.  OR clause will return both women and men. ) 

 

b.  Note that when you are working in the query editor, you can see the results by hitting 

the exclamation point (some call it the Run Query button and others call it a “bang”).  

 

c.   Did you notice? There is a button between the Edit as Text box and the Run Query 

button.  You  can use the Import button to bring in SQL directly from a file, if you 

prefer not to cut and paste. You can also change the dropdown box from text to work 

with Stored Procedures instead.  

 

d.  Did you find it faster and easier to start with something you have previously 

completed instead of starting over?  
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Exercise 5:  Advanced Dataset - Multiple Joins / Filters 

Now we can combine the concepts we’ve learned in previous exercises and go a step 
further to add more than two tables and some advanced complexity.  
 
 

• For this exercise, pull up and edit the dataset you created in Exercise 2.  

• Add a third table, CALLS.  Bring in the entire table. Now you have 3 tables. 

• Add a relationship that links the CALLS table to the other two tables.  

o You want to see only those CONSUMERS having at least one SERVICE 
DELIVERY and having at least one CALL.  

• Filter your query to return records where: 

o  the consumer is over 60 AND married;  

o OR where the consumer is female and head of household.  

• Save your work with a new file name. 

 

Give it a try – use the hints below as needed, then check your results against the debrief on 

the next page.  

 

Hints:  Don’t forget to save your work under a new name.   

 

• You now have three tables.  They share one common field.  

• You want to see only those Consumer records matching on Service Delivery and 

matching on Calls.  

o You could get extremely complex with this query.  

o If you were looking truly for the intersection of the three tables, you would 

probably be writing a SQL statement that creates a temp table or 

intermediate results set. We’re not asking you to do that here.  

o You may get different answers in the results when you play around with the 

joins. Exploration is encouraged.  

o Any answer is acceptable as long as you join all three tables.  

• Check the Consumer fields for a shortcut on Female+Head of Household. 
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Exercise 5 – Debrief 
 

1.  As noted above, the SQL for a multi-table query can get very complicated, and possibly 

beyond what can be accomplished with the visual (graphic) interface. When you get into 

very advanced queries, you should be prepared to use the text editor.  

• Note that you cannot toggle back and forth – when changes are made in 

the text editor, and you unclick Edit as Text, you will lose any 

modifications on return to the graphical interface.  

• When working in complex dataset / query construction, copy and paste your 

syntax into notepad or a Word document if you need a handy way to save 

versions of your work while you are editing.  

• You really only need to join > 2 tables if the additional table has fields in it that 

must be included in your dataset.  

Outer Joins would return all Consumers regardless of match to calls or service deliveries. 

Use of Inner Joins means you will only see records where there is a match: 

 

Syntax:   

FROM HAR_CONSUMERS 

   INNER JOIN HAR_SERVICE_DELIVERIES  

 

ON HAR_CONSUMERS.CONSUMER_UUID = 

HAR_SERVICE_DELIVERIES.CONSUMER_UUID 

 

INNER JOIN HAR_CALLS ON  

HAR_CONSUMERS.CONSUMER_UUID = HAR_CALLS.CONSUMER_UUID 
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Exercise 5 – Debrief  (continued) 

 

2.   Use the arrows to move your filters up or down.  

 
 

Move filters to create syntax WHERE: 

1.  HAR_CONSUMERS.IS_FEMALE_HOHH is N'Y' 

2.  HAR_CONSUMERS.AGE > 60  

3.  HAR_CONSUMERS.MARITAL_STATUS is N'M'. 

 

When you have them in the order you want, then click Edit as Text.   

Once you are in text mode, modify the SQL in the Text Editor to convert the “AND” after 

AGE > 60 to “OR”.   

 

Save your work, then run the query.  

3.  Did your query return any data?  It probably did not.  

 

 
 

The reason no data was returned is because the syntax as stated doesn’t correctly reflect 

the values we are looking for in the WHERE clause.  

Let’s look at the data and check the data format for these fields.   We know that AGE is 

good, but we’re not so sure about the other two fields, HOHH and Marital Status.  

Make sure you have saved your work so you can come back to this query later.  

Then, create a new query.   

Select from HAR_CONSUMERS the fields we need to use in our Exercise 5 filter: 

a) IS_FEMALE_HOHH   b) MARITAL_STATUS.  Since we’re checking format, let’s also 

pull in c) LAST_DETAILS_UPDATE to get a feel for formatting on data-time fields.  

Run the query.  Now you can see the correct data format for those fields.  
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Exercise 5 – Debrief  (continued) 

 

 

IS_FEMALE_HOHH format is 

‘Yes’ or ‘No’ (and maybe NULLs too) 

 

 

MARITAL_STATUS format is 

‘Widowed’ 

‘Married’ 

‘Divorced’ 

‘Separated’ 

Or NULL (may be other values also).  

 

 

 

LAST_DETAILS_UPDATE format is 

‘MM/DD/YYYY hh:mm:ss AM’ 

Keep this information handy so you 

can filter on this field later if needed.  

 

Now we see the problem. Data format is incorrect for both Marital Status and HOHH.  

 

Erroneous Syntax:   

WHERE HAR_CONSUMERS.IS_FEMALE_HOHH = N'Y' 

  OR HAR_CONSUMERS.AGE > 60 

  AND HAR_CONSUMERS.MARITAL_STATUS = N'M' 

 

Conforming Syntax: 

 

WHERE HAR_CONSUMERS.IS_FEMALE_HOHH = N'Yes' 

  OR HAR_CONSUMERS.AGE > 60 

  AND HAR_CONSUMERS.MARITAL_STATUS = N'Married' 

 

Run the query again, and you should get data this time: 
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Exercise 5 – Debrief  (continued) 

 

Note that the query returns records for both females and males.  

 

That’s because the WHERE clause we’ve defined is an “OR” convention.  

 

Records returned reflect either 

• “Female HOHH = Yes”  (female records only, if data is good) OR  

• “Consumer > 60 and Marital Status = “Married” (could e either gender).  

 

 

Also note that in the Check Format query on page 20, there’s a filter set for Age > 80.  

 

Why do you suppose we filtered that Check Format query? 

 

• Whenever you are checking for data format, it’s a good idea to include a filter that 

will limit the records returned. You don’t need to see thousands of “married” 

records to discover that the convention is “married”.   
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Section II – Report Definitions 
 

Exercise 6:  Build Table Report 

In this exercise, you will develop a Report Definition (.rdl file) using the shared dataset you 
created in Exercise 1.  
 
If that dataset is very large, open the dataset and add filters to limit the records returned 
before you complete the Report Definition in this exercise. Then save the modified work as 
Exercise 6. See below for suggested filters. This combination will limit the results set to two 
weeks of new consumers.  
 

 
 
A report using a HAR_CONSUMERS dataset can be useful when you need to count 
attributes in your consumer base, such as reporting on the number of people in certain age 
or income groups, or a count of those meeting other demographic criteria.  
 

• Using the Reports Wizard, follow the steps to create a new table report. 

• Choose the dataset you created in Exercise 1 or a filtered version as needed.  

o Arrange Fields:  

• Place RES_COUNTY as a Row Group.  

• Place GENDER as a Column Group. 

o Add Values: 

• Count the Distinct number of CONSUMER_UUIDs. 

• Save the report definition with an appropriate name. 

• Save your work  to the correct Library in SharePoint.  

 

Give it a try – use the hints below as needed, then check your results against the debrief. 
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Hints: 

 

• Connect to Report Builder via AgingNetwork.com. 

• You may have to browse to SharePoint > Reports Library > Your Folder.   

• Remember that your Exercise 1 file is a dataset:  (.rds) 

• Follow the steps in the wizard to create new report. 

• Be sure to save your work before you run the report.  
 

 

Exercise 6 – Debrief 
 

1.  To create this report, start with File > New to bring up the Report Wizard.  

Choose Table Report, then for the data source, choose the.rsd file created 

previously in Exercise 1 or the modified version named Exercise 6. 

 
2.  Once the dataset is selected, Report Builder will prompt you to Arrange Fields.  

You will be able to make changes later, when you are working in Designer mode.  
 
To produce the report to the requirements in the exercise, your screen should look 
like the one below.    

 

 
 
 
 

Moving Available Fields: 

To move the fields to the applicable box (Row group, Column Group, or Value), highlight the 

available field on the left, and then drag and drop the field into the desired box.  

You do not have to use all of the fields in your dataset. Items not moved into a Row, 

Column, or Values box will not appear in your report.  When you create shared datasets, 

don’t hesitate to bring over anything you might need. If you don’t need all the available 

fields, you simply don’t pull them into your report definition.  
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Values Box: 

When you need to perform math on a field (SUM, COUNT, MIN, MAX, AVG, etc.), it needs 

to go into the Values box.   

Note that you must have at least one field in the Values box.  Once fields are moved into 

the Values box, you can highlight a field and use its fly-out menu (upside-down triangle on 

the right of the selection) to specify what type of math you want on the field.  

 

 
 
 
Dates 

• You can do math on dates, however, this usually exceeds what can be accomplished 

with the report wizard, especially if you need to add a column to display your results.  

If you want to tackle date math in your report, use the wizard to get you started, then 

handle the more advanced development within the report designer instead.  

• You can convert dates to numbers in your SQL statement and do calculations that 

way as well.  

• See examples below for typical uses of math on dates. Please note that the 

“equations” are conceptual, rather than the actual syntax you would use in an 

expression.  

o To calculate future follow up or due date: DATE+[# of days ahead] 

o To check for overdue or expired:  TODAY’S DATE – DUE DATE 

o To see first occurrence of something: DATE [MIN] 

o To see the last occurrence of something: DATE [MAX] 

o To count number of dates with activity: (RANGE) DATE [DISTINCTCOUNT] 
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SUM / AVERAGE / STD DEVIATION 

• Although you can apply these functions to integer fields like CLIENT_ID, the results 

will not be meaningful.  Generally, these functions are used with numeric fields such 

as Cost or Units.  

 

COUNT / COUNT DISTINCT  

• COUNT will tell you the number of rows having any value. DISTINCT will tally the 

number of unique values in all the rows returned.  Note that null values may be 

counted as a value, and blanks may be counted as another value.  

 

MIN / MAX 

• Can be used to identify the earliest or latest date, the lowest or highest value, the 

least or most frequent value, and/or the range (lowest and highest)of values within 

the data.  

 

General Tips and Additional Practice: 

1.   If you have any difficulty dragging and dropping fields into the boxes, make sure you are 

“grabbing” the field on its label, at the far left. When you grab on the right, the system 

“thinks” you wish to highlight multiple selections. 

 

 

 

If you continue to have difficulty with dragging and dropping fields into the other Arrange 

Fields boxes, it may be a product issue.  Inform your local Technical Support 

Administrator and/or if you are the administrator, send an e-mail outlining the problem 

and the  user(s) affected to support@harmonyis.com. This will open a tech support case.  
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2.  Take care when working with the fields dragged into the Values box.  Make sure you 

have only highlighted the one field you wish to configure. 

 

Middle field is highlighted: Bottom two fields are highlighted: 

  

 

3.   When you enter fields into the Values box, pay attention to the order in which you bring 

them over, because it can be tricky to move columns later. Generally speaking, you 

should drag the field over in the desired order of appearance (left to right on the report). 

The last field in the list dragged in, appearing at the bottom of the list in the box, should 

be the field you wish to use for the grand total – typically the UUID, when counting 

Consumers.  

 

4.   Once you finish in the Report Wizard, the system will bring up your report in the Report 

Design view.   
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It can be helpful to develop a regular process for fine-tuning your report definitions. 

Consider doing your development in a consistent order: 

 

a. Title – Click the Title Box to give your report a title. 

 

  

b. Column Widths – Click inside a column to get the little gray row-column cells. Click 

the column gray cell at the top and then drag its boundary to the right to set the 

desired width for the column. 

 

 

c. Recommendation:  Save the report before you run it or make major changes to the 

data or layout. This will save you some time if you need to come back and start 

again. 
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Adds, Deletes, and Substitutions – Let’s suppose you decide you want to bring in 

Cons_Agency_Des on the report.  This could give you a report counting Consumers  

by Agency, then Res_County. 

1.   Open the Datasets folder on the Report Data pane.  

o Expand the folder labeled Datasets. 

  

o The pane will show all available fields in the entire dataset, even if you 

originally only used a few of the fields in the Report Wizard.  

•  When you have the folder open, you can click and drag the desired field from the 

dataset list over into the design pane.  Drop the new field into the top of the Row 

Groups pane. If you don’t get it where you want it, click undo and try again.  

 

Notice that the field now appears on the report layout.  
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2.  You can also delete items. There are at least three ways to delete something. 

 

Location Steps Looks Like 

From  

Datasets 

Right click the 

target Field  

and select  

Delete.  

From  

Layout 

pane 

Right click the 

target Column  

and select  

Delete Columns. 

 

From  

Grouping 

pane 

Click the drop 

down button  

and select  

Delete Group. 

 

 

Confirm if you wish to delete only the selected column, or if you also want to delete any 

associated groups.  Your design objective will determine the correct choice. 

 

d. Built In Fields – add to your report any of the available fields.  

• Execution Date/Time Stamp appears by default. You can remove it if you wish. 

• After dragging desired fields into the report, you can right click to define 

properties for your objects, and you can move them to the location you prefer.  

• Note that if you wish to insert &Page of &PagesTotal, you will need to use the 

Insert tab to add a text box between the built in fields for the word “of”.  

e. Parameters – to add a parameter to your report, right-click the Parameters folder in 

the Report Data pane. 

f. Images – to add an image (logo, photo, icon) to your report, right-click the Images 

folder. Then locate the desired image and place it into the Report Design pane.  

5.  When you have completed your initial design, SAVE THE REPORT.  If you try to run it 

before saving the report, you may get an error that can result in re-work.    
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6.  After you save the report, click the Run button.  Note that if you have added any 

parameters to the report, the designer will prompt you for the value of the parameter 

before it will allow you to view the report.  

 

 

 

7.   In running the report, note that the results for COUNTDISTINCT on Consumer UUID 

returns the unduplicated number of consumers for the AAA – RES_COUNTY 

combination.  

• COUNT DISTINCT has limited meaning within some fields (Gender, for example), 

because each record will always result in a distinct count of 1.   

• The objective of COUNT DISTINCT is to check the number of differentiated values 

for the entire dataset.   

• If you decide you don’t want an unduplicated count, you can change the field 

property to COUNT instead. Click inside the cell showing the CountDistinct function, 

then right click, and uncheck CountDistinct. Check COUNT to replace the value.  
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Did you notice?   This report has multiple pages. That means you will only see the 

totals for the report as a whole by checking the last row of the last page.   

 

 

 

Guided Exploration: 

Using this report, try some different things to see what happens when you make certain 

changes: 

1. If the field is designed as a Column Group, the results run across the top of the page. 

To add a column group, drag PRIMARY_ETHNIC_GROUP over to the Column 

Group box under the report preview pane. Then click on the fly-out menu to define 

Group Properties.  Set the Group Properties to Group on this new field.  

 

 

The report will now display results by ethnic group across the top: 
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1. There is a difference between COUNT and SUM.   

Change the value on your report definition to Summarize By Sum: 

 

 

• When you run the report, do you get an error?  While it is possible to 

SUM the CONSUMER_IDs, it would not be meaningful to do so.  

• Set the value back to Count or Count Distinct and the error should 

resolve itself.  

 

2. Did you notice?  When you right click to bring up the Summarize By menu, you must 

have your cursor inside of the label for the cell. You’ll get a different menu if you are 

not within the cell’s text.  

3. Also note:  When you bring up the Summarize By menu, you will notice another 

option directly below Summarize By. The Expression option allows you to bring up a 

text-based editor that lets you directly define the expression for the cell.  
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Exercise 7:  Build Chart Report 

The objective of this exercise is to create a chart showing Consumers by Primary Ethnic 
Group.  
 

• You will need to define an embedded dataset containing only those fields you need 
for the chart.   Typically for chart reports, you want to limit data to only what you will 
use.  

• Using the Reports Wizard, follow the remaining steps to create a chart report. 

• Make your chart a pie chart in Ocean Style.  

o You can play with the look of the chart later if you wish. 

• Save the report definition with an appropriate name. 

• Save your work  to the correct Library in SharePoint.  

 

 

Give it a try – use the hints below as needed, then check your results against the debrief on 

the next page.    

 

Dataset Hints: 

 

• Don’t try this with a shared dataset.  

o Or if you do and it works, please let us know what you did. ☺  

• You only need two fields. One is grouped and one will be counted.  

• You’ll need to decide if/how you want to see blanks and nulls.  

 

Report Hints: 

 

CAUTION!  This exercise can be tricky and frustrating. Limit yourself to about 60 minutes of 

trying to figure it out. If it takes you longer than that, go to the debrief and follow the steps as 

outlined, then try a variation on the exercise to practice with the various options.   

 

This exercise exists only to help you become familiar with the process and the options in 

Report Builder. So spend up to an hour poking around to see what is possible, but don’t be 

too hard on yourself if you don’t get a perfect chart the first time through.  

 

In fact, if you find it exasperating to work in Report Builder for creating charts, it may be 

easier and faster to use ART to generate the data you need, then export that data to MS 

Excel, where you’ll have far more control over how the chart is rendered.  There is no “ Law 

of the Universe” that says you must create charts and graphs using one tool over any other.  
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Exercise 7 – Debrief 
 

The easiest way to debrief this exercise is to simply take you through each step needed to 

produce the required chart.  You can follow along and do the steps on your own if you like, 

and then when you “have it”, you can go back and start over, repeating the steps until you 

feel comfortable with the process.  

 

Step 1:  Select File > New > New Report > Chart Wizard, then > Next. 

Step 2: Click Create a New Dataset > Next.  

Step 3: Select your Data Source > Next. Enter credentials when prompted. 

Step 4: Expand the Database View so you can choose from the CONSUMERS table. 

Step 5: Check the boxes for PRIMARY_ETHNIC_GROUP and for CONSUMER_UUID. 

• Do not apply any grouping or aggregation to the fields, then click > Next.  

 

Step 6:  Select Chart Type of Pie, then click > Next.  

Step 7:  The system will present the Arrange Fields page.  

• Drag PRIMARY_ETHNIC_GROUP into the Categories box.  

o The Categories box is where you put the subject of the report. 

• Drag CONSUMER_UUID into the Values box. 

o The Values box is where you place the measure for the subject. 

o Each chart must have at least one aggregate value. 

o In this report, your aggregate value is Count.  

• Your Report Builder screen should look like the following: 
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Step 8:  Click Next.  Then choose a Style (Ocean),  then click > Next.  

• Report Builder will return a preview of your report.  

 

 

• Notice that the report labels aren’t in the preview, and you can’t tell at this point 

what the chart will actually look like when it’s run with data.  

• Also notice that the chart is pretty small in comparison to the size of the page. 

Step 9:   Click to add your title, then click on and resize (expand) the chart to fit the page. 

Step 10:  You do not have to save the report before you run it, because your dataset is 

embedded.  Click Run.   

Your results may look something like this: 
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Step 11:  The dataset contained a category of “blank” or “null”. In this case, running a report 

against the data while trying to figure this out revealed that there were no “nulls” 

but there were some “blank” values in the data.   

 

Report Builder didn’t know what to do with this odd value, so it named it “Point 1”.   

This slice is also very small and hard to see.  It makes sense to give this slice the 

label of “other” and if there are multiple small slices, to combine the ones of less 

than 5% into one larger slice. Here are the steps to accomplish this objective: 

 

• To combine any slices on the pie chart smaller than 5 percent into one slice: 

o Switch to report design view by clicking the Design icon. 

 

o On the View tab, in the Show/Hide group, check the box to show Properties.  

 

o On the design surface, click on any slice of the pie chart. The properties for 

the series are displayed on the right, in the Properties pane.  
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o In the General section, expand the CustomAttributes node. 

 

 

o Set the CollectedStyle property to SingleSlice.  

o Verify that the CollectedThreshold property is set to 5. 

o Verify that the CollectedThresholdUsePercent property is set to True. 

 

 

 

Step 12:  On the Ribbon, Go to the Home tab, then click Run to preview the report.  
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In the legend, the category "Other" now exists.  

The new chart consolidates all the slices that were under 5% into one larger slice.  

(In this case, there was only one smaller slice, so no consolidation occurred.) 

 

 

 

Step 13:  Now we can label the slices with the % to total.  Click the Design icon. 

• Select the pie, and right click to bring up the chart menu. 

• Highlight Show Data Labels and click it.  
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Step 14:  Now we can format the labels. Switch to report design view. 
 
 

• Right-click a label, and then click Series  Label Properties.  
 
(There is a bug in the application – you may not be able to complete step 14.) 
 

 

• In Label data, from the drop-down box, 1) select #PERCENT.   

• To display values as percentages, the UseValueAsLabel property must be false.  

If you are prompted to set this value in the Confirm Action dialog, 2)  click Yes.  

 

• To specify how many decimal places the label shows, type #PERCENT{Pn} where n 

is the number of decimal places to display.  

o For example, to display no decimal places, type #PERCENT{P0}. 

 

o Number Format in the Series Label Properties has no effect on % formats.  

• Click Run to preview the report.  
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The report displays the percentage of the whole for each pie slice. 

 

 

Step 15:  Now we can enhance the colors. Switch to report design view. 

• Right Click on the pie and select Chart > Chart Properties. 
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• Under General properties, change the Color Palette to Fire. 

 

 

• Click OK, and run the report again.  Try all the palettes to see what you prefer.  
 

 
 
Now that you know the process for creating a pie chart, try adding a header to your legend, 
and explore some of the many options available to you.  
 
You can even try some advanced and custom functions using the right-click menus and 
expression options.  
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Section III – Embedded Datasets 
 

Exercise 8a: Build Report with Embedded Dataset 

In this exercise, you will develop a Table report using the Consumers and Service_Delivery 
tables to generate an embedded data set.  
 
Embedded datasets can be useful when you need to pull a report together quickly and you 
are certain you won’t need to re-use the dataset.  
 
Step 1:  Select File > New > New Report > Table Wizard, then > Next. 

Step 2: Click Create a New Dataset > Next.  

Step 3: Select your Data Source > Next. Enter credentials when prompted. 

Step 4: Choose your data.  

• From the CONSUMERS table, select the following fields: 

� CLIENT_ID 

� CONSUMER_UUID 

� CONS_ AGENCY_DES 

 

• From the SERVICE_DELIVERIES table, select the following fields: 

� CARE_PROGRAM_NAME 

� SERVICE_YEAR 

� SERVICE_MONTH 

� FUND_IDENTIFIER 

� CONSUMER_UUID 

 

Step 5:  Establish the appropriate relationship(s). 

Step 6:  Add a parameter on Service Year with default of 2011.  

Step 7:  Follow the wizard to create a report of your own design.   

Step 8:  Save the report.  

 

Give it a try – use the hints below as needed, then check your results against the debrief on 

the next page.  

 

Relationships Hint: 

 

• 1) First turn off Auto-Detect.  2) Then Click Add Relationship. A 

• 3) If you can’t see the pane, click the down arrows to expand the view. 
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Debrief - Exercise 8a 
 
You’ve already built most of the query part, back in Exercise 3, as a shared dataset. 
 
1.  Your Report Builder screen should look like the following: 

 

 

Explanation: 

• Note that to make the Filter a Parameter, simply check the box on the right.  

•  When this box is checked, the report runner will need to specify a value for the 

report at run time. In other words, the system will prompt the user to define the 

value of the filter when the report executes. 

•  If you do not make the Filter a parameter, this dataset will always return only the 

records where SERVICE_YEAR is more than or equal to 2011.  

• If you make it a Parameter, the report will still be filtered on SERVICE_YEAR, but 

the USER will define “more than or equal to what year, if any”.  

• Here’s one possible report layout: 

 

• Save the file, then run the report and make adjustments as needed.  
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Exercise 8b: Insert Column and Concatenated Field 

Let’s start with the report created in 8a.  In this exercise, we will insert a column containing a 
concatenated field to the report definition created in 8a.  

• A concatenated field takes two fields and joins them together. 

• Concatenation is usually performed to enhance a report’s display.  

• You can concatenate text and strings.  

• To concatenate numbers, you must first convert the numbers to strings.  

 

Begin by opening the report you created in 8a.  

Step 1:  Go to Report Design view.  Insert a new column into your report. 

• Click to show the gray cells around the layout.  

• Select the desired column.  

• Right click and select Insert Column > Left or Right, as you prefer. 

 

 

Step 2:  Name the new column: 

• Right-Click the blank Column Header cell and select Text Box Properties. 

 

• Enter the desired column label in the Value box.   
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Step 3:  Define the new field - a concatenation of two other fields. 

• You want it to display as:  SERVICE_YEAR / SERVICE_MONTH. 

• Since the two targeted fields, SERVICE_DELIVERIES.SERVICE_YEAR and 

SERVICE_DELIVERIES.SERVICE_MONTH, are numbers instead of string, we 

need to use a conversion function to convert to string first, then we can 

concatenate the fields.  

• The correct syntax for the expression is as follows: 

 

=CStr(Fields!SERVICE_YEAR.Value)&"/"&CStr(Fields!SERVICE_MONTH.Value) 

 

Step 4:  Now that we know the correct expression for the new column, we can add it. 

• Right-click the cell beneath the column header and select Expression. 

 

 

• Copy and paste the conforming syntax into the expression editor. 
 

 



WORKBOOK FOR REPORT WRITERS HARMONY ADVANCED REPORTING 

 

v 1.0  (08/26/11) © Harmony Information Systems, Inc.  Page 47 

• Copy and Paste, or repeat the process, for the remainder of the cells in the column. 
 

 
 
 

Step 5:  Run the report.  It should render like the following: 
 

 
 
 
 
3.  We’ll talk about your reports in the next training session. Play around and explore.  

• Be prepared for the next session to discuss the challenges you encountered and 
how you addressed them.  

• Be prepared to explain your report to others in the session and talk about your 
design decisions and lessons learned in creating the report.  
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Section IV – Advanced Expressions 
 

Exercise 9a: Unduplicated Clients Report 

In this exercise, you will develop a new report to count unduplicated clients for a period of 
time and fund code.   
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Exercise 9b: Insert Age_Range Logic 

In this exercise, you will create a new dataset without the graphical wizard, and your query 
will specify the age ranges you wish to see in the dataset.  
 
Step 1:  Open Report Builder. 
 
Step 2:  Go to File > New > Dataset.  
 
Step 3:  Click the Edit as Text button. 
 
Step 4: Copy the SQL query below, and paste it into the query editor: 
 
SELECT 
   HAR_CONSUMERS.CONSUMER_AGENCY_DES 
  ,HAR_CONSUMERS.RES_COUNTY 
  ,HAR_CONSUMERS.AGE 
 
 ,case when Age <= 54 then 'Under 55'  
 
            when Age >= 55 and Age <= 59 then '55-59'  
 
            when Age >= 60 and Age <= 64 then '60-64'  
 
            when Age >= 65 and Age <= 69 then '65-69'  
 
            when Age >= 70 then '70+'  
 
  end Age_Range  
 
FROM 
  HAR_CONSUMERS 
 
Step 5:  Save the query.  
 
Step 6:  Run the query (click the ! symbol). 
 
Did the results return the data you expected?  
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Exercise 9c: Define Parameter with Drop Down 

In this exercise, you will create a query to populate a drop down box that can be tied to a 
parameter having numerous options.  
 
This tip comes in handy when you have a large data set. To avoid queries that time out, you 
can put parameters on the dataset, and you can configure the parmeters to allow selection 
of a value from a drop down list.  
 
Examples where this “look up filter” approach can be especially helpful: 
 

• Agency 

• County 

• Care Manager (large organization) 

• Fund Code 

• Service 

• Etc.  

There are several parts to setting up this type of parameter: 

Part I.   Create the lookup dataset. 

Part II.  Establish the parameter within your dataset query. 

Part III. Configure the parameter’s available values to come from the lookup dataset.  

 

Part I: Create Lookup Dataset 

There are several ways to approach the requirement to create a lookup dataset for zip 

codes in Texas.  

 

Option A:   

Pull available data values from CONSUMERS.CONSUMERS_RES_ZIP. 

• This option pulls from actual entries in the system.  

• Downside: there may be some bad data in the records.  

 

Option B:   

Pull available data values from VIEWS> ZIP_CODE.ZIP_CODE.  

• This dataset already has a postal service-correct set of zip codes. 

• Downside: The list contains all USPS values so we would need to do some 

serious manipulation to make the list “Texas only.” 
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Option C:  

Write a query to create a range of valid values for Texas.  

• http://www.paweb2.com/zip.htm carries valid zip code ranges by state.  

• Here are the numbers for Texas.  

 

• The series has some gaps, so “OR” clauses will be needed. 

 

Let’s assume we want to go with Option C – write a query to create a dataset containing 

valid values for Texas.   

 

Step 1: Go to Report Builder > New > Create New Dataset. 

Step 2: Click the Edit as Text button.  

Step 3: Copy the query below and paste it into the editor.  

SELECT DISTINCT HAR_CONSUMERS.RES_ZIP  
    FROM HAR_CONSUMERS  

   WHERE (HAR_CONSUMERS.RES_ZIP = N'73301'  
           OR (HAR_CONSUMERS.RES_ZIP BETWEEN N'75001' AND N'75501')  
           OR (HAR_CONSUMERS.RES_ZIP BETWEEN N'75503' AND N'79999')  
           OR (HAR_CONSUMERS.RES_ZIP BETWEEN N'88510' AND N'88589'))  

         AND HAR_CONSUMERS.RES_ZIP NOT LIKE '-%'  
         AND LEN(HAR_CONSUMERS.RES_ZIP) >= 5  

ORDER BY HAR_CONSUMERS.RES_ZIP 
 

Step 4:  Save As, name, and then run the query.  
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 Part II: Establish parameter within your dataset query 

 

Step 1:  Build the dataset query. See below for sample query information: 

 

 

The RES_ZIP parameter must be included within the dataset’s query.  

 

 

Part III: Configure the Parameter 

 

Step 1:  Build the report definition.  

 

Go to New > Create Table Report > select your query, and then design the layout.  
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Step 2:  Confirm that the report has the parameter RES_ZIP.  

 

  

 

 

Step 3:  Bring in the dataset that will serve as the drop down list of available values. 

 

1. Right-click on the Datasets folder and select Add Dataset.  
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2.  Browse to, and select, the zip codes dataset created earlier.  

 

  

 

3.  Click Open, then click OK.  

  

 



WORKBOOK FOR REPORT WRITERS HARMONY ADVANCED REPORTING 

 

v 1.0  (08/26/11) © Harmony Information Systems, Inc.  Page 55 

Step 4:  Configure the parameter. 

 

1. Notice that a second dataset is now available in the report data pane: 

 

 

2.  Right click the RES_ZIP parameter and select Parameter Properties.   

 

3. Set General properties as follows: 
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4. Set Available Values properties as follows: 

• Choose “Get values from a query” 

• Dataset = drop down: select the zip code dataset you added to the report 

• Value field = drop down: select the parameter field 

• Label field = drop down: select the value field 

 

 

5.  Configure default value(s). 

• This step is important for large datasets. Always limit the query where you can. 
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Step 5:  Save, then run the report, selecting the desired parameter value at run time.  
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Section V – SharePoint Component Exercises 
 

Exercise 10: Establish Report Subscription 

In this exercise, you will develop a Report Subscription to schedule a report that will execute 
on a defined timing and frequency.  
 
Requirements: 

• Create a report of your own choosing; ideally, select one that you have built from 

scratch for your own Reports Library.     

• Add a schedule to the report as follows: 

o Run report every Tuesday and Thursday 

o Run report at 7:00 AM 

o Run the report between October 1, 2010 and September 30, 2011 

 
 
Hint: 
Follow the instructions in the Getting Started Guide if you get stuck.  
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Debrief - Exercise 10 
 
1.   The instructions in the Getting Started Guide cover detailed step-by-step instructions 

with screen shots to illustrate each step.  

 

2.  After you establish your report subscription, wait for the next time the report’s schedule is 

triggered.  After you hit that date/time,  check the Reports Execution Library.  

 

• Was the report there?  

o If the report ran, save a copy so you can compare the data to the next 

one to confirm what has changed.  Export to .pdf and retain a copy 

either in the Reports Execution Library or on your desktop if you prefer.  

o When the next update has occurred, compare your versions. Depending 

on your data refresh cycle at the warehouse level, you should see 

different results for the same report definition.  

• If the report didn’t run, investigate. 

o First contact one of the more experienced users to practice 

troubleshooting the problem locally before calling Harmony.  

o If you cannot determine and resolve the problem, contact Harmony and 

escalate the issue so we can investigate.  
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Exercise 11: Create New Folder 

In this exercise, you will create a new folder in your Reports Library.  
 
Requirements:  Follow the steps below to add a new folder. 
 

 
 
Step 1:  Go to the Reports Library. 
 
Step 2:  On the Library Tools tab, click Documents. 
 
Step 3.  Click the New Folder button. 
 
The system will return the New Folder Window. 
 

 
 
Step 4:  Name the folder.  (Required Field).  
 
Step 5:  Click Save.  
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The system will place the new folder into the Reports Library, ordered by folder name. 
 

 
 

 You can also store documents in the Reports Library.   

• Create a new folder.  

• Name the folder “Reference.”  

• Upload the Getting Started Guide and the Training Workbook to the new folder. . 
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Exercise 12: Move Files to New Folder 

In this exercise, you will move files to the new folder.  
 
Step 1:  Open (in Report Builder)  the object that you wish to move.   

  
 Step 2:  Use Save As to save a copy of the file to the new folder.  
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Go back to the Reports Library.  The report now appears in the new folder.  
 

 
 
 

Notes: 
 

It’s important to control your reports environment and to keep your files organized, which 

can become more difficult if multiple copies of each report exist throughout the system.   

In other words, take time when you copy a report  to follow through and perform any 

related cleanup that may be warranted:  

• First, test that the file is working properly after the move.   

• Once verified, consider deleting copies that are no longer needed.  

• You CAN move shared datasets into a new folder, however, taking this 

action may “break” any reports that rely on the dataset to be available in its 

current location.  You should be able to correct the problem by opening the .rdl 

files and reconnecting to the shared dataset in its new location, then save the 

change.  

• There should be no problem in moving report definition files or reports with 

embedded datasets.   
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Alternate Method:   
 
You could copy the file to the new folder entirely in SharePoint without using Report Builder: 
 
 
Step 1:  Open the new folder and copy its URL. 
 

 
 
 
Step 2:  Return to the Reports Library.  
 

 
 

Step 3:  Highlight the file you wish to move. 

Step 4:  Click the item to get the pop-up menu, and Highlight Send To. 

Step 5:  Select Other Location. 
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The system will bring up the Copy window. 

 

 

Step 6:  Paste the destination folder’s URL in the Destination field.  

 
If you wish to control the file, you can elect to have the system prompt the author to send 
updates when the document is checked in.  You can also check the box in the Update 
section to create an alert that will enable the system to notify you whenever the source 
document changes.  
 
Step 7:  Click OK.  
 
Note:  There is a limitation in SharePoint on the allowable size of the file name.  
 

If you get the message below, the alternate method is not an option. 
You’ll need to do a Save As from Report Builder. 
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Exercise 13: Change Report Name 

In this exercise, you will rename a report within the Reports Library. 
 

Caution:  If you rename a shared dataset, you will “break” any reports that rely on the 

file to be found under a certain name.   

To change the name of a report definition (or a report with an embedded dataset), follow the 

steps outlined below: 

 

Step 1:  Go to the Reports Library.  

 

 

Step 2: Highlight the filename to be renamed.  

Step 3: Click the triangle on the right of the file name to show the pop-up menu. 

Step 4:  Select Edit Properties. 
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Step 5:  Enter the desired new name for the file. 
 

 
 
 
Step 6:  Click OK. 
 
 
The file will now appear in the Reports Library under the new name. 
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Exercise 14: Delete File 

In this exercise, you will delete a report that is no longer needed. 
 

Caution:  

1.  If you delete a shared dataset, you will “break” any reports that rely on the file.  

2.  If you delete a folder, all contents of the folder will also be deleted.  

3 . If you delete an item, it may be unrecoverable.  

 

To delete an item from the Reports Library or the Reports Execution Library, follow these 

steps: 

Step 1:  Highlight the file to be deleted and select Delete. 

 

 

Step 2:  Confirm that you wish to delete the file. 
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Exercise 15: Restore File 

In this exercise, you will recover a file that was accidentally deleted.  
 
Caution:  
 
1.  Not all users will have access to restore files. 
 
2.  Not all files can be restored.  
  
3.  Restorable files not restored within 30 days can never be recovered.  
 
To restore a file, follow the steps outlined below. 
 
 
Step 1:  Locate the Recycle Bin link on the Quick Launch pane and click it.  

 

 

The system will bring up the Recycle Bin, which contains recently deleted objects/files. 
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Step 2:   Mark the checkbox next to the file you wish to restore.  

Step 3:  Click Restore Selection.  

 

 

 

Step 4:  Confirm your intention to restore the file. 

 

 
The file is restored to its prior location (Reports Library or Reports Execution Library). 
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Congratulations ! 
 

You’ve completed the exercises for Harmony Advanced Reporting. 
 

Please contact education@harmonyis.com with any suggestions, feedback, corrections, 

and comments you may have about any of your training materials and experiences.    

 

We’d love to hear from you! 


